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Dear customer,

Thank you for choosing Anycubic products.

Maybe you are familiar with 3D printing technology or have purchased
Anycubic printers before. However, we still highly recommend you read this

manual carefully, as the installation techniques and precautions can help you
avoid any unnecessary damage or frustration.

Please visit https://support.anycubic.com to contact us if you have any

questions. You can also learn more information from the website, such as

software, videos, models.

e

Anycubic support center

Copyrighted by “Shenzhen Anycubic Technology Co., Ltd ”, all rights reserved.

Team Anycubic


https://support.anycubic.com/

Safety Instructions

Always follow the safety instructions during assembly and usage, to avoid
unnecessary damage to the 3D printer or individual injury.

Please contact our Customer Service if you have any issues after
receving the products.

Be cautious when using the scraper. Never direct the scraper towards
your hands.

In case of emergency, please immediately cut off the power of the 3D
printer and contact our technical support.

Anycubic 3D printer includes components that can cause injury.

Keep the Anycubic 3D printer and its accessories out of the reach of
children.

Vapors or fumes may be irritating at operating temperatures. Always
use the Anycubic 3D printer in an open and well ventilated area.

Do not expose Anycubic 3D printer to any water or rain environment.

Use Anycubic 3D printer in an environment with a temperature of 8°C-
40°C and a humidity of 20%-50%. For optimal performance, do not
exceed this range. Also, avoid direct sunlight exposure.

Do not disassemble Anycubic 3D printer, please contact technical
support if you have any questions.
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Product Overview

1. Cover
5. Z axis
2. Print Platform
©@
3. Resin Vat @ (
4. Touch Screen
6. USB Port
[ 1
ol
® _ /@ w%ﬂ% 8. Power Switch

7. Power Port



In the Box

ANYCUBIC

Photon Mono M5s  Print platform * 1 Resin vat * 1 Hex key set

<=

USB drive * 1 Protective equipment Funnel*5 Scraper * 2

i
|

Power adaptor Manual * 1 Screen protector kit



Technical Specification

Operating System

System Photon Mono M5s
Touch Screen 4.3-inch Resistive Screen
Software Anycubic Photon Workshop

(also compatible with other software)

Connectivity USB Drive, WIFI

Specifications

LCD screen 10.1 inch 12K
Light source Matrix LED light
XY Resolution 11520 * 5120

Z axis Accuracy 0.01T mm
Suggested Layer Thickness 0.01 ~0.15 mm

Physical Dimensions
Dimension 290 mm(L) *270 mm(W) *460 mm(H)
Build volume 218.88 mm(L) *122.88 mm(W) *200 mm(H)

Weight 8.9 kg



Recommended Print Parameters

Parameters @ Default (2 Default 3 High Speed
Group Resin_Normal Resin_Fast Resin
Layer Thickness 0.05 mm 0.1 mm 0.1 mm
Normal. Exposure 28¢ 3205 175
Time
Off Time 0.5s
Bottom Exposure 25 ¢ 10°s
Time
Bottom Layers 5 4 3
Z Lift Distance 8 mm 5mm 3mm
Z Lift Speed 6 mm/s 20 mm/s
Z Retract Speed 6 mm/s 20 mm/s
Anti-alias 0

1.If the print object needs high accuracy, please use
group ® and modify the anti-alias level as 16 and the
image blur as 3.

2. The group @® can significantly increase the print
speed by cases test. To ensure the print success and print
speed, do not modify the parameters casually.

Notice 2. The group @® apply to the model whose hollowed
thickness is no more than 2mm.

3. The group @® must work with the 3rd Gen High-
speed release film this printer provided to avoid print
failure. The film can be used to print 30000 layers.

4. Refer to 16-18 pages for the instructions of parameter
groups.

--The data above root in Anycubic lab, only for reference.
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Menu Directory

Tools

Move Z:

Move Z by 0.1Tmm
Sl Ut /1mm/10mm/50mm

Move the Z axis upwards

Move the Z axis downwards

Exposure :

ERTENALE Choose an image to expose
= 3 ___J| Choose anima 92 to expose

__S_e_F_th_e__e_)_(_p_(_D_S_L{r_?_t_IT_e_ oonl 10s - 30s 405  50s Sl set the exposure time

Expolsure b Return tO the TOOl.S Menu

. Start exposure

Vat Cleaning:
Vat Cleaning
Set the exposure time
T R o€l LNE ex posure time
_ Startexposure p@ ; =3 Return to Tools Menu
Monitor:

Reset the print times

Statistics of print times

Statistics of print layers

———————————————————————————

Enable/disable X Auto Device Check - EnabIE/disable
error automatic pause [ EEE——_—G——— @ ‘auto device check

Number Of Print:

Number Of Layers:

= Return to the Tools Menu
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Menu Directory

Information

Language:

Service:

Information:

Print history |

uage
e
fistc

More Settings:

N ”"" 4|  Official Website : https://www.anycubic.com/

Language

v (D Setthe language

Official website

e Delete the record

Layers: | e - e e
Total Time:

Completion Status:

Name: Page doWn

Layers: 1 L

:;:;:w; Status: Error 404 REturn to the Info Menu

Enter into the version interface

@ Version >

Dt Turn on/off the screen sound
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Menu Directory

Version:
Printer system
System version
Serial number
Printer ID
Upgrade:

Current firmware version

Cloud

Cloud:

WiFi connection

Network settings:

Name of the network

| System

Photon Mono M5

I Version Information

Enter into upgrade interface

" = Return to the More Settings

I Version Serial Number

Update

I Current

OTA upgrade

I Latest

| Optimization

WiFi connection status

Netwaorks

Anycubic APP
Printer Hotspot

nfo ‘

WLAN

Set server

Server Location
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1. Turn on the printer and then wait for the auto device check. The printer
automatically checks the hardware help you shooting the troubles and
reduce the print failure. When there is an error, the printer will pop up the

error QR code. Please scan the code and follow the guide.

LCD screen connection
Check the connection of LCD screen to avoid the exposure error caused by
bad connection.

Force Detection
Check whether the force sensor that affects the resin volume detection
and leveling detection works.

Motor connection
Check the connection of motor to ensure it works properly.

If you disable the auto device check, the printer will not automatically

check the hardware condition.

Click 2 times
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3. Install the screen protector.

Peel off the protective film Peel off the film @ Align the location holes
Clean the LCD screen with screws and squeeze
with tool kit out the bubbles

Peel off the film @

4. Install the print platform.

Push the platform onto Tighten the knob
the platform carrier

5. Choose an exposure image to test.

—
o

The white part is

exposure area
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6. Install the resin vat.

Put the resin vat with its feet Tighten two knobs

stuck in location holes

15



File Upload

USB

1. Use Anycubic Photon Workshop software to process the 3D model file.

The installer and instructions is saved in the USB drive.

2. When you set the parameters in Anycubic Photon Workshop, there are
three groups of parameter which can be apply to the print with different
needs.

Machine Configuration Manage X

Preset Printers Machine Resin

Anycubic Photon Mono M&s

n ] [ EditResn JEU R K R | R
Name Resolution Exposure [ Bottom
Defautt Resin_Normal :x:vs
Default Resin_Fast [ 0.100mm |
High Speed Resin [ 0.100mm | [ 1.400s]

Choose the parameter group according to the personal requirement

@ Default Resin_Fast
Apply to the Anycubic resin with fast printing speed. The layer thickness is
0.1Tmm. It increases the average print speed of the maximum model to

60mm/h by optimizing the Z-axis motion control.

@ High Speed Resin
Apply to the Anycubic high speed resin with the fastest printing speed. The
layer thickness is 0.1mm. It increases the average print speed of the

maximum model to 100mm/h by optimizing the Z-axis motion control.

16



File Upload

Notice for using the parameters of Default Resin_Fast & High Speed Resin:

1. The parameters apply to the model whose hollowed thickness is no more than
2mm.

2. The parameters must work with the 3rd Gen High-speed release film this

printer provided to avoid print failure. The film can be used to print 30000 layers.

® Default Resin_Normal

Apply to the Anycubic resin with normal printing speed. Also, the intelligent

mode is available for the parameter group.

* Intelligent mode
The software can set the normal exposure time through analyzing the

model features to increase the success rate of printing and improve the

print effect.

| Information
Resin Name Resin Volume(ml) 1000.000
Resin Type Standard Resin =~ v Resin Price 220.000 $ v

| slice Parameter Intelligent Mode ‘:)
Layers Thickness(mm) 0.050 - Control Type Basic ~
Normal Exposure Time(s) - Z Lift Distance(mm) 8.000 z
Off Timals) 0,500 2 ZLift Speedimm/s) 6.000 z
Bottom Exposure Time(s) 25.000 . Z Retract Speed(mm/s) 6.000 >
Bottom Layers 4 :
Anti-alias 16 ~
Gray Level 0 ~
Image Blur 2 ~

N

+ Expert mode (disable the intelligent mode)

Set all slice parameters according to the personal requirement.

17



File Upload

If the intelligent mode is enabled in slicing (A), the mode can be switch to
expert before printing. If the intelligent mode is disabled in slicing (B), the

mode can not be changed.

Mode can be changed Mode cannot be changed

3. Save the sliced file to USB drive.

4. Then, insert the USB drive to the printer.

" Notice for the USB drive:

. @ Itis recommended that use the USB drive we provide. If you are using your
own USB drive, please ensure that it is formatted to FAT/FAT 32 and has a
memory size of less than 32G.

(2 To ensure proper file reading, please put print files in the root directory of

USB drive.

18



File Upload

Cloud

Please connect the printer to Anycubic App first for remote uploading and monitoring.

1. Check whether it is global server. If not, click to switch to the global
server and wait for the printer restarting.

Server Location
= WLAN p—

Server Location

Printer Hotspot

Networks
Anycubic APP

Printer Hotspot

3. Please search “Anycubic” in App Store or Goolge Play, or scan the QR
cord on the printer, to download Anycubic App. Then, sign up and sign in.

4. Add a printer in Anycubic App.

Workbench < Add printer Help

Printer network is reset

B3 File > O Task > 1. Turn on the printer switch and enter the system in the
main menu of the screen

-

|

2.1n the system menu, click the Connect APP button on
the right

Help More >

Photon M3 Max FF R {FHISA ﬂ

®

Workbench Use other methTo add|

Network has been 1

19



File Upload

5. Connect to printer’s hotspot.

< Anycubic
< Settings WLAN Edit

< Add printer
Networks

Anycubic APP c 0
WLAN
o ©

Printer Hotspot @,/ AC-A21A5F019A83 @“‘» o}
/' AC-XXXXXXXXXK =0 | SR — L ] -
MY NETWORKS = L : y

MY NERWORKS

Connect to printer's hotspot

AC-XXOXNKX *Q@

AC-5EEAD8059C51 =0

Please connect the printer to the following printer hotspots
AX56U a= 0
Check the printer’s hotspot uitos e
After successful connection, please return to this screen RT-AX86U 8= @
RT-AX86U_5G a= 0

OTHER NETWORKS

AC-AGBE1701ASDF =0
Acl a0
ANYCUBIC-guest a0
ANYCUBIC-office a0
ChinaNet-CVzw a= 0

Select the printer’s hotspot

6. Return to App, connect the printer to the network.

< Add printer Add printer

Printer hotspot connection successful

Connected: AC-A21A5F019A83
Please select the WiFi the printer needs to be connected

The printer is connecting to the network
Please stay on the current page and do not leave

WiFi list

o. ‘ b4
J
= Redmi L
Connecting16%
= office

% ANYCUBIC-guest @ Transfer WIFI information to the printer

RT-AX86U # Printer connection successful

P)

ANYCUBIC-office

Please enter WIFI hotspot password

)

ANYCUBIC-guest

)

ANYCUBIC-office

P)

js2b-wifi

P)

Act

P

ANYCUBIC-office

= OPPO . Tips: Next
The leveling of the print platform is very important. Printing the
= RT-AX86U first layer is the foundation of the entire model. The first layer is
good or bad, and directly affects the effect of the model
printing. After one leveling, later printing does not need to be
T adjusted every time.
= office

% ANYCUBIC-guest

Select WIFI Enter in password

Notice:

@ The location and local network must be allowed to use during connection.
@ Please ensure the connection to printer’s hotspot during the network
connection to avoid connection failure.



File Upload

7. Printer is added successfully. Search model or upload the model files.

e Search model

Workbench Search model

More than 1 million printable
B Fie > O Task >
& Popular searches:  alien  flexi harry potter

5 deadoralive  onimask terminator v
Printer More >

Recommend Sliced Newbie zone

Anycubic Photon Mono M5s I

© Available
Total printing time: 0 hour 0 min

Total consumption Resin: Oml
Printer type: Anycubic Photon Mono M5s

A
.
. tortoise Free 3D print Gridfinity Pick + Tweezer

model recommendation Cchange model Racks

Cgtrader Thangs
. n nm
Batman on a roof CATBUS(MY NEL..  Cobb Vanth
Early summer Early summer Early sum)

Help More > Ironman helmet with Succubus
S prnting. opening mechanism e

© S

Workbench

D

Q) o Q

Search model

* Upload the modelfiles

Workbench < File Space use0.008/2.0068
B F > O Task >
Printer More >
There are currently no printable files, Please upload model or
slice files
Anycubic Photon Mono M5s
® Available
Total printing time: 0 hour O min
printer model recommendation C Change

Total consumption Resin: Oml

Printer type: Anycubic Photon Mono MSs
Batman on a roof

.
model recommendation CChange @ «yle white
B CATBUS(MY NEIGHBOR TOTORO)
\ B Daniel Toledo
Lonwillgg  Cobb Vanth from Star Wars the
= Mandalorian
Batmanonaroof ~ CATBUS(MY NEL.  Cobb Vanth 'k%x\
Early summer arly summer Early sum " @ raryOhers
Help More > B Chained One
initiate printing

Harry Olvera
® 5

Workbench

21



File Upload

Cloud Connection Troubleshooting

Issues Troubleshooting Solution

Check whether it is
printer's hotspot

Fail to connect to
printer's hotspot in

App

If not, please reconnect to
the printer's hotspot.

If not, please click [@ in
Cloud menu on the printer to
reset WIFI. Then, connect the
printer to network again.

Check whether the WIFI
and its password is
correct

The printer prompts | Check whether WLAN
that WiFi on printer is the WIFI
connection failed )

If not, please click . in
Cloud menu on the printer to
reset WIFI. Then, connect the
printer to network again.

Join an available network.
Click @ in Cloud menu on
the printer to reset WIFI. Then,
connect the printer to
network again.

Check whether the WIFI
network is unavailable

Connection Status

WiFi module off WiFi module on WiFi module on
disconnected disconnected connected

22



Print Test

*The release film on the resin vat is consumable. Please pay attention to the
status of release film on the touch screen and replace the film timely.

Please check the release film carefully before and after every printing. If the
film is broken, replace it immediately to avoid further damage to the machine.

1. Make sure you wear masks and gloves (to avoid direct skin contact with
resin), slowly pour resin into the vat with resin level not exceeding the
vat’'s maximum scale.

( )

2. Print file.

« USB drive file

* Remote print

Workbench < Print Online slicing
Cloud Local
B File > O Task >
Printer: Anycubic Photon Mono M5s
Printer More > TEST .stl

;ggt‘k

Type: model file

Size: 54.35MB
Anycubic Photon Mono M5s S 2022-03-25 10:00:00
. )
Total printing time: 0 hour 0 min & Prig
Total consumption Resin: Oml
Printer type: Anycubic Photon Mono MSs

.

TEST stl

Type: model file

model recommendation CChange L5 Size: 54.35MB
& 2022-03-25 10:00:00
e nm
y " & Print
i |
AL,
Batmanonaroof ~ CATBUS(MYNEL..  Cobb Vanth
Early summer Early summer Earl

Help More >

©

Workbench
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Print Test

(D Before printing, the printer checks the hardware condition, resin volume
and leveling before each print job. When there is an error, the printer will

pop up the error QR code. Please scan the code and follow the guide.

1 Auto Print Check

Resin

Check whether the volume of resin in the vat is sufficient to finish the print job.
Usually, the required resin volume is a little more than the resin volume
estimated by the slice software.

If it prompts that the resin volume is not enough, please add resin and then
check it again.

Leveling
Check the leveling to avoid the print failure caused by layer separation or other
errors.

(2 During printing, the printer automatically monitors the conditions which
may cause print failure and prompt the error to the customers in case resin
is wasted or even damage the printer. When the printer detects an
abnormal condition, it will pause the print job automatically and pop up
the error report. Please check the sliced file and the model according to the

report.

Bottom non-stick detection

It monitors the condition that model does not stick to the print platform.

When the printer detect the model does not stick the platform, please check the
bottom exposure time of the file.

24



Print Test

The resin detection and error auto pause can be disable and then the

printer stops the prompt.

Disable the functions
you don't need

3. When the printing is finished, resin may be cured partly in the vat. Please
set to Vat Cleaning and remove the residue.

Remove resin sheet
by plastic scraper

4. Finishing

» After printing, remove the platform when resin stop dropping from the
platform. Remove the model by metal scraper and then wash it with 95%
alcohol or other detergent. It may need post-curing to achieve better
hardness by being exposed directly to sunlight or a UV-curing machine.

« After printing, there might be some cured resin left in the vat. Please
clean the vat timely, and filter the remaining resin by a funnel. Otherwise,
it may cause damage to the release film or LCD screen. If you do not use
the resin now, it is recommended to store it in an airtight container away

from light.

25



Resin Exposure Range Finder

“R_E_R_F" is an abbreviation for “Resin Exposure Range Finder”. This function

is used to find out the optimal exposure parameters for different resins.

1. Import the R_E R F file which is saved on USB drive into the slicing
software. There are eight models in the file. The exposure time for model 1
is equal to "normal exposure time (s)" of the file, and the exposure time for

other models will be increased by an increment of 0.25 s.

The numbers on the models indicate their order

2. According to the personal requirement, adjust the exposure time of the
models by modifying "normal exposure time (s)” of the file. When exposure
time for Model No. 1 is changed, the exposure time for other models will be

increased by an increment of 0.25 s.

For example, when normal exposure time is set to 1.5 s, the exposure time
for Model No.1-8is:1.5/1.75/2/2.25/2.5/2.75/ 3/ 3.25 s.

3. After printing, remove and clean the models. Compare the print effect of
models and choose the model’s exposure time that meets your needs as

the print parameter. Take a comparison of model A&B as an example.

26



Resin Exposure Range Finder

e oy More cylinder

« Model A has more holes and fewer cylinder. If you print by the parameter
of model A, more details of model can be printed with high risk of failure.
« Model B has fewer holes and more cylinder. If you print by the parameter

of model B, model may be printed successfully yet with some details lost.

In addition, you can compare the bridges, needles or other parts to choose
a proper model and find the parameter. If none of them can be chose,

adjusting the "normal exposure time (s)" is suggested.
Notice: DO NOT change the file name of “R_E_R_F"”, because Anycubic 3D printer

can only recognize THIS file name to run this function. Also, do not name other
fileas “R_E_R_F".
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Model do not stick to platform

Bottom exposure time is insufficient. Please increase the exposure time.

Contact area between the model and platform is small. Please add a raft.

Layer separation or splitting

The machine is not stable during printing.

The release film is not tight enough or needs a replacement.
The printing platform or resin vat is not tightened.

The lift speed is too fast.

The model is hollowed without punching.

Layer shift

Add supports.
Reduce the lift speed.

Floccules left in resin vat or attached to models

* The exposure time is too long. Reduce the normal exposure time and

bottom exposure time.
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Maintenance

Resin Vat Maintenance
* Remove the cured resin from release film: Set Vat Cleaning and then

remove the cured resin sheet to protect the film. Do not use sharp objects

to scrape off the residues on the film.

Remove resin sheet
by plastic scraper

* Release film replacement: The statistics of print times and print layers

are shown in Monitor interface. Please check them and replace release

film timely to avoid print failure or even the damage to printer.

Replace release film Click reset button
at this time after replacement

» If you do not use the resin for over two days, store it in an airtight

container away from light.

Firmware Upgrade
Check whether the current firmware needs update. “Optimization” shows

what'’s new in the latest firmware.
» USB upgrade: Visit the official website to download the installer and
save it to a USB drive. Then, insert the USB drive to printer to upgrade.

* OTA upgrade: If the network is connected, directly upgrade by OTA.

OTA / USB upgrade

29



Maintenance

Z-axis Maintenance

If Z axis makes a noisy sound, please apply lubricant to Z lead screw.

Cleaning

* Clean the print platform: Clean platform with alcohol and paper towel.
* Protect LCD screen : If the resin cured on screen protector, please
replace it immediately to protect LCD screen.

» Clean the body of printer: Clean the body of the printer with alcohol.

Thank you for purchasing Anycubic products! Under normal usage and
service, the products have a warranty period of up to one year. Please visit
Anycubic support center(support.anycubic.com/en) to report any issues
with Anycubic products. Our professional after-sale service team would
respond within 24 hours and solve the issues.
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